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ABOUT THE TURNING TUTORIALS
The Turningmodule is themost basic of the functions supported by the system. This tutorial
provides basic instruction on how to create turning operations. You will be guided through tool
setup, process definition, operation creation, custom stock definition, cut part rendering and form
tool use.

For creation and using a form tool, see “Exercise #2: 2D Form Tool” on page 37.
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EXERCISE #1: TURNING TUTORIAL
The following tutorial shows how a simple lathe part is set up, tooled and output. Each step is
bulleted and additional information and tips are also provided. It is recommended that you read all
the information contained in this tutorial in order to gain themost thorough understanding.

The part was created in the Geometry Creation tutorial and a copy is provided in the sample parts
file. Dimensions for the part can be found in the part prints section at the end of the tutorial, see
“Lathe Part Blueprint” on page 45.

Refer to the Geometry Creation tutorial for details on constructing the geometry for this part. You

may convert betweenmetric and imperial units (mmand inch) with theModify > Scale
command if necessary.

This tutorial explains how to:
1. Setup the Part - How to set up stock, clearance and tool change settings.

2. Specify custom stock.

3. Create a tool list with standard and custom tool settings.

4. Generate different types of operations that rough, contour, drill and thread a part.

5. Render themachining operations.

6. Create posted code for the part.

Part Setup
1. Open the Document control dialog found in the top left corner of your screen. You can

also use (Ctrl+1) or (F1).

The Document control dialog contains information about theMachine Type,Material,
measurement system, stock, Tool Change, Clearance and a part Comment. It also has the file
management tools to open, save, close, etc.

2. SelectOpen in the Documents dialog.

3. Locate the Turning tutorial part that you created using theGeometry Creation tutorial.

If you do not have the part, one is provided in the sample parts file (Sample
Parts/Production/Tutorial Parts - Required/Lathe Tutorial.vnc).

4. Enter the stock, Auto Clearance and Interop Positions shown.



Exercise #1: Turning Tutorial

5

Interop Positions will send the tool to the specified location for the tool change. If Tool Change is
unchecked, it is assumed that fixture offsets are being used, or the operator will manually input
the tool changemoves.

Auto Clearance sets the default clearance values of each process unless overridden by
unchecking Use Auto Clearance in the Process dialogs.

i

The Auto Clearance option will calculate part clearances (in both Z and Xd/Xr) that are used
to position the tool between operations. These values are dynamically calculated as the
stock condition changes asmaterial is removed. The clearance positions calculated will
also take into account where the tool needs tomove to begin the next operation’s
toolpath. Additionally, the Auto Clearance optionmay add entry and exit moves as needed
to safelymaneuver around the part and complete each toolpath.

5. Close the Document control dialog (Ctrl+1), (F1), (Ctr+W).

6. Open the View palette (Ctrl+5), (F5).

7. Choose Help > Balloons from theMainmenu.

Balloons provide a reference to the interface. The icon will be highlighted in blue, indicating that
it is on. Move the cursor over objects to see the balloon help information.

8. Select Unzoom (Ctrl+U) .
The part may already be unzoomed if the part was saved.

9. Select the Isometric view (Ctrl+I).

The Isometric view is a 45° perspective of the part. This view gives the best overall perspective of
the current status of a part from the top, right and front view of the part.

The Top or Home view is recommended for creating geometry and toolpaths, while the Isometric
view is an excellent choice for rendering and viewing the cut part.
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10. Choose Help > Balloons or Ctrl+B to deactivate them.

11. Switch back to the Top view. (Ctrl+E or (Ctrl+H).

12. Click the View button again to close the View palette, (Ctrl+5) or (F5).

Now look at the bottom left of the screen. You will see an axismarker. Hover over thismarker
and you will see a Trackball appear. This is very useful to enable quick view changes tomade. You

can change the position of thismarker to any corner of the screen by editing the File >
Preferences > Display > Edit Appearance Settings > Background location (or turning it off).

Now try right-clicking on the center of the
trackball or view palette. A dropdownmenu
appears with a Customize option. This option
enables you to add common commands to your
trackball, simply by dragging them onto the
required buttons. Extra commands can be added
in combination with the Shift, Ctrl and Alt keys.
Use the Reset option to delete the customization.

Look at the bottom right border of the screen. This area gives basic information about the part (Inch
or metric). Current Coordinate System andWorkgroup are shown (click them to open the dialogs).

The Trashcan and Progress bar are also situated here, where they are easily accessible. If your
part is to be duplicated, this will also be indicated.

13. Double-click the CS button. The CS dialog opens. Use

the to close the dialog.
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Custom Stock

The stock specifications entered in the Document Control Dialog simply creates a cylindrical
stock shape using the X and Z coordinates entered. It is possible to define a custom stock shape by
drawing the stock shape in a separate workgroup designated for part stock.

This is very useful because the stock shape affects themachining of the part in that the stock
conditions are used to calculate the clearance positioningmoveswhen using Auto Clearance. The
custom stock shape also appears when viewing the rendered image of the part.

1. Open theGeometry palette in the Command palette (Ctrl+2), (F2).

2. Click theWorkgroup list button.

TheWorkgroup dialog opens.

This button also accesses a workgroup selectionmenu if you hover
over it with themouse. Themenuwill be discussed later in this
tutorial.

Or you can simply double-click theWGbutton on the bottom bar to open the dialog.

3. Click and double-click the name and delete it. Rename it “Stock”.

A second workgroup is created and is now the current workgroup, indicated by the open eye.

4. Right-click the "Stock" workgroup name, from themenu, choose WG Info.

TheWorkgroup #2 dialog defineswhether the workgroup will contain part geometry or a stock
outline.
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5. Select the Part Stock Revolve option.

6. Close theWorkgroup #2 Info dialog.

You will notice that the icon in the workgroup dialog Type
column has changed to a blue solid cylinder to indicate
revolved part stock.

In order to create the geometry for the stock outline, it will be necessary to view the part
geometry that we have already created as amachining workgroup. The entry highlighted in the
Workgroup Selection dialog is the active workgroup.

Other workgroups can be viewed by opening the eye next to their name in theWorkgroup
Selection dialog. Geometry in inactive workgroups are displayed in gray and cannot be edited
while inactive.

7. Double-click the closed eye next toWorkgroup #1.

Both eyes are now open.Workgroup 2: Stock is highlighted to indicate that it is the active
workgroup.Workgroup #1 is visible but inactive (colored grey).

8. Close theWorkgroup list.

Wewill use theMouse-line tool in the Geometry Creation palette to draw a rough outline of the
stock. Any geometry creationmethod can be used to create a stock outline.

9. Click the view command and choose home view.
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10. Click the Line button in the geometry creation palette.

Note that the activeWorkgroup name is displayed at the top of the palette.

11. Click theMouse-Line button.

TheMouse-Line dialog contains Z and Xd values
determined by the location of the cursor. The Grid
value specifies constraint spacing the lineswill snap
to. For a review on using theMouse-Line tool, refer
to Exercise #5: Doodle in the Geometry Expert
Section of the Geometry Creationmanual.

The initial stock is a cylinder with two different diameters for our stock outline. The stock does
not need to be perfect, but should not cross the finish geometry defined. The only requirement is
that the bottom linemust be drawn at X0 to have a correctly revolved part.

12. Draw a stock shape around the part as
shown.
This will be the stock condition before cutting is performed.

13. Close theGeometry Creation palette.

14. Hover over theWorkgroup Selection button until the selectionmenu appears.

15. Select Workgroup 1 bymoving themouse to the option and then clicking.

Tool List

1. Click the Tool list button in the Commands palette.

2. Double-click tile position #1 in the empty tool list.

The Tool Creation dialog contains all tool specifications necessary for the system to calculate
accurate toolpath and rendering. Tool information can be edited at any time by clicking on tool
tiles and editing the information contained in the Tool dialog. For more information on Tools,
refer to the Turning user guide, "Tools" chapter.

3. Select the 80° C insert with the following specifications.
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Values for insert specifications,
such as Tip Radius, IC (Inscribed
Circle), Thickness, etc. can either
be selected from the list of
standard inserts in themenus or
manually entered by selecting
Other.

Holders can be chosen by using
the scroll bar next to the insert
diagram. The text to the right of
the scroll bar displays the holder
specificationswhich provide
detailed information about the
insert angle and holder type. For
our part, the first position
provides the desired selection.
The red plus sign at the end of
the insert indicates the touch-off
point of the tool.

The selection of insert and tool holder also affects the toolpaths created using this tool. The
system uses the selectionsmade here when constructing a toolpath to prevent tool interference.
Therefore, selectionsmade here directly affect themachining of the part.

4. Double-click the empty tool tile at position #2.

This closes the Turning Tool #1 dialog and opens the Turning Tool #2 dialog. A tool tile displaying
the insert type and tip radius you created appears in position #1 of the tool list.

This next tool is a drill, so use the scroll bar to scroll up to theMill tools.
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5. Select the Drill tool with the
following specifications.

6. Double-click tile position #3 in the Tool List.

7. From the Lathe Tools, select the 35° V diamond insert.

8. Enter the tool information
shown.
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The position on the insert orientation diagram remains the same as the previous insert selection,
so no adjustment is necessary.

The insert angle and holder type selection is the last one in the group.

9. Create this insert as tool
#4.

10. Create this insert as tool
#5.
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11. Create this insert as tool
#6.

The Insert Orientation Diagram changes in appearance when the Boring Bar option is selected.

12. You canmake the tool tile list longer or shorter as you require by positioning the cursor on the
bottom of the list.

When the cursor changes to "up and down" arrows, click and drag the list up or down.

The scroll arrows at the top and bottom of tile lists allow you to easilymove through the tiles
in the list. To go to the top or bottom of the list, click the smaller underlined arrow button. To
scroll quickly through the list, hold down the larger button and drag themouse downward.
This will change the arrow to red and scroll a “page” at a time. For more information on tile
lists, refer to the Getting Started guide.
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13. Create this insert as tool
#7.

Once the Style and TPI (threads per inch) values are selected, the InsertWidth and Insert Typewill
default to the desired values.

14. Create this custom insert as tool
#8.

15. Close the Turning Tool #8 dialog.
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The tools necessary tomachine this part have now been created. A good way to review the
tools contained in the list is by using theWindow > Tool List Summary.

16. ChooseWindow > Tool Manager.

The Tool Manager contains all of the current tool information in a customizable list.

Print or Save to file options are available in the ToolManager heading area.

17. Close the Tool Manager.

Creating the Operations - OD

1. Click the Tool and CAMbuttons in the Command palette, , (Ctrl+4) or (F4).
The Tool, Process andOperation Tile Lists appear.

In order to machine this part an Operationmust be created. Operations are defined within
Process dialogs.
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To create a Process, one Tool and one Process type (roughing, contouring, drilling, or
threading) is needed. Drop a Tool from your tool list onto a Process Tile and choose the process
you require. The Process dialog will appear. This is where you define themachining
parameters. If you prefer, you can also simply double-click a Process tile, select a Process type,
then choose a tool from the suggested tool list (or create a new one).

Once this is done youmust select the geometry to define the cut path and a click of the Do It
button creates anOperation in the operation list.

In this tutorial, we will first describe the necessarymachining operation, then wewill detail the
steps necessary to create that Operation.

First, we will create anOperation that will face the front of the part.

2. Double-click Process Tile #1 and select the Contouring Function Tile.

The Tool selection dialog appears.

3. Choose the 80° C diamond insert (Tool #1). You will notice that the tool number
is now displayed on the Contouring Process Tile.

 The Contour Process dialog now appears.



Exercise #1: Turning Tutorial

17

4. Enter the information
shown in the Contour
dialog.

To position the tool to cut
the face of this part, we
need the tool to approach
and retract along the Z axis.
Therefore, the Front Face
option is selected.

For this process, theMaterial Only option is selected so that no toolpath will be generated
unnecessarily to cut the face.

5. Close the Contour Process dialog.

1. Start point
2. Offset cut
3. Start feature
4. End Point
5. End Feature
6. Centerline
7. Cut Direction

When the Process dialog
is complete, the cut shape
must be defined.
MachiningMarkers are
used to designate a cut
shape for contouring
processes.

8. Select the vertical line on the X axis at
Z=0.

TheMachiningMarkers will appear on the selected feature. The black and white arrow markers
allow you to specify the start and end feature and the start and end point of the cut shape. They
can be “picked up” by clicking on them and dragging them to any location on the part
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geometry. The arrows allow you to choose the cut direction. The two circles allow you to choose
the side fromwhich the tool will be offset.

In this case, the start feature and end featuremarkers will stay in their initial positions because
only one feature, the face, will be cut. The start point and end point markers will bemoved to cut
the entire length of the face. The start and end point markers can rest anywhere on the selected
line, even on the trimmed sections. For more information onMachiningMarkers, refer to the
Turning user guide, "Machining" chapter.

If you find that theMachiningmarkers are too small, the size can be changed in the Preferences
dialog. Go to File > Preferences > Display >Marker Size and choose the size that is right for you.

9. Select the outside circle.

This is the OD side of the
geometry.

10. Click the arrow pointing
down.

Wewill approach the line
from theOD and bring the
tool just past the center to
ensure a complete facing is
done.

11. Drag the round white start
point marker above the
workspace as shown.

BecauseMaterial Only is used in this process, the start and end point markers do not need to be
placed in exact positions as long as they clear the stock outline we defined.

12. Drag the end point marker down to the location shown.

If markers are not properly placed a processmay not generate the desired toolpath. The
commonmistake is to chose the wrong cut side.

13. Click the Do It button at the top of the Contour dialog.

AnOperation tile will be created and added to the Operation list on the right of the screen. The
approach and retract moves, and the toolpath will be drawn. The orange lines represent the
toolpath, while the dashed gray lines represent positioningmoves. The solid lines for both the
toolpath and positioning indicate feedmoves. And the dashed lines of both colors indicate rapid
moves.

The picture above on the right shows the toolpath without theMachiningMarkers so you can
see it better. To view the toolpath without theMachiningMarkers, simply click anywhere off
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the part. The dashed gray line shows the tool rapiding from the tool change position (entered in
the Document dialog, to the start point of the toolpath).

The angled lines at the beginning and end of the toolpath are entry and exit positioningmoves
that have been added because Auto Clearance is turned on. They are angled along the centerline
of the insert angle. The position the tool can safely rapid to before beginning the toolpath is
determined by the Auto Clearance value entered in the Document dialog.

14. Deselect the operation created by clicking on an emptyOperation location, or by clicking
an insertion point betweenOperation locations.

Tiles are considered selected when they are highlighted in yellow. Deselected tiles are the
standard gray color.

Creating Operations

i

When operations have been satisfactorily completed, it is VERY IMPORTANT before
proceeding that all operations are deselected. By deselecting the completed operations,
they become fixed in the Operations List and will not be affected by changesmade to the
Process List. Operations can be edited, but to do so theymust be reloaded into the
Process List by Double-clicking on them.

1. Mouse-drag the Process in position #1 to the Trashcan to delete it. When the hand icon is
over the trashcan, the trashcan lid will open. Letting go themouse button will then deposit
the Process in the Trashcan.

When creating a new Process, you can either throw away the old tiles in the list or modify them
in order to create the new operations. In this case wewill throw away the old tile and start from
scratch.

The next group of operationswill rough and finish the outside contour of the part. This will be
accomplished usingmultiple process programming which allowsmultiple processes to be
applied to one cut shape.

Multiple Process Group Op 2-4

2. Create the following Rough process by double-clicking Process Tile #1, choosing
Rough from the available processes and then selecting the 80° Diamond insert
tool (Tool #1).
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To properly position the tool to rough the
OD of this part, we need the tool to
approach and retract along the X axis.
Therefore, theOD option is selected for the
approach type.

Lathes use different roughing (multiple cut) cycles. There are three general types: Turn, Plunge,
and Pattern Shift. These three types of cycles will allow us to output the different canned cycles
defined in programmingmanuals for lathes. The software will output these roughing cycles as
canned cycles if the Prefer Canned option is selected and the lathe is capable of using canned
cycles. If not, the post processor will output everymove necessary to rough the part.

Turn roughing cycles are the standard contour rough cycle. For turning cycles, the selection
made for the approach type (OD, ID, Front Face) determineswhat type of contour rough style will
be generated by the system.

Plunge roughing cycles are used to generate grooving operations. These cycles are used when it
is desirable to rough the part with a groove tool. Pattern Shift roughing cycles are commonly used
when roughing a cast part. This type of cycle generates the part contour and shifts the toolpath
on each successive cut until the specified area is roughed.

In this process, we will use a turn roughing cycle. When a turning cycle is selected, a Cut Depth
value is entered which designates how muchmaterial will be removed on each pass.

For this process, the Cut Depth value entered is 0.1. The Xr label indicates that it is a radius value.
Thismeans that 0.1" of material will be removed from each side on each pass.

The Cut direction axes check boxes allow you to regulate the axes and directions of the cut shape.
Omitting an axis (such as X-) will prevent cut shapemoves in the disallowed direction. For more
information on cut shapes and the Cut direction Axes buttons, refer to the Turning user guide
"Machining" chapter.
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For this process, the X axis in the negative direction is turned off. This will prevent the toolpath
frommaking anymoves in the X- direction so it does not go into the grooves.

The value entered in the Fin. Stock ± text box designates theminimumamount of material that
will be left outside of the part geometry after the roughing cycle is completed. The toolpath
created by the systemwill be offset from the part geometry in Z and in Xd.Wewill remove this
excesswith the finish pass.

3. Close the Rough Process dialog.

4. Create another Roughing
Processwith the 35°
Diamond Insert (Tool #3) in
position #2.

This process is included in this group to rough the neck groove on the part. Again, anOD
approach type is selected so the tool will approach and retract along the X axis. And a Turn
rough cycle is selected using a Cut Depth.

Material Only is again selected for the Rough Style so that the toolpath generated for this operation
will only cut the remainingmaterial left on the part after the previous operations have been
completed. TheMaterial Only selection is particularly useful when utilizing themultiple process
programming capabilities of the system. Feedmoveswill only bemadewhere it is necessary to
removematerial. The tool will make rapidmoveswhenever possible while maintaining the
clearance offset.

We have also enabled chip breaking, which will occur if the chip length becomes greater than
100.
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In addition, entering a finished stock amount will leave the designated amount of material
around the entire cut shape.

5. Close the Rough Process dialog.

6. In position #3 create this
Contour processwith tool
#3.

7. Close the Contour Process dialog.

Now that the Process List is complete, we will define the cut shape.

8. Click the chamfer as shown.

MachiningMarkers will appear on the selected feature.

9. Click the outside circle. (1)

10. Click the arrow pointing up. (2)

11. Drag the Start Point Marker to the position shown. (3)

The Start and End Point Markers do not need to be placed in exact locations as long as they
clear thematerial.

12. Drag the End FeatureMarker (black square) and drop it on the part geometry as shown.
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The End Point marker will automaticallymove with the End Featuremarker.

i
Alternately the End FeatureMarker can be placed by pressing (Ctrl+Shift) and
clicking on the end feature geometry.

When positioning any one of the four machiningmarkers on a geometry feature, place
the tip of its arrowhead on the geometry feature.

13. Drag the end point marker to the position shown.

The Dark blue line represents the cutting path. Notice that themiddle V groove and theO-ring
groove are not included in this cut shape.

14. Click the Do It button or press (Ctrl+).

This will create the toolpath. If anymistakesweremade, edit the process and use the Redo
button tomake changes to a selected operation.

Three operations are created.

TheOperation list should have four operations now.

The positioningmoves and toolpaths for each of the operations are also drawn on the screen. In
order to get a better picture of the toolpaths generated by the system, wewill view the tool
moves for the first roughing operation separately.

15. Select Operation #2.

Clicking once on a tile will select and highlight the tile without opening any dialogs or selecting
other tiles that were created with it.

16. Open the View Control palette.

17. Click the Redraw button (Ctrl+R).

Only the toolpath and positioningmoves for the selected operation are drawn. This is helpful if
you usemultiple process programming and wish to view individual toolpaths.
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Notice that the custom stock outline was taken into account because Auto Clearance is on and
theMaterial Only option was selected. Also, the toolpath created does not slope at all into the
neck groove because the X- Shape Axis was deselected in the Rough Process dialog that
created this operation.

The dashed gray lines show the tool rapiding from the end point of the previous operation to the
start point of this operation, and to the tool change position at the end of the operation.

Now that operations have been created, we will render the part. There are several ways to
verify that the toolpaths generated by the systemwill safely and correctly cut the part. Looking at
the toolpaths, as we have done thus far, is one way. Another way is to render the part which
allows you to actually view the tool removingmaterial and cutting the part.

Now select Operation Tile #3. You will see the chip breaking toolpath. You will probably need to
slow the display speed dramatically to see this properly.

18. Choose View > Isometric from theMainmenu (Ctrl+I).

19. Click the Op Sim icon on the Command palette.

The initial stockwe defined at the beginning will display as a solid object. Ensure that the Lathe

stock cutaway button is set to quarter cutout, the tool visibility is set to visible tool. Use the
slider to slow down the rendering speed if necessary.
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TheGeometry is hidden but can be overlaid by using the show geometry button (Ctrl+[).
Options can be changed without resetting the rendering, or you can rewind to watch from the
beginning.

20. Click the Play button.

The tool is shownwhilst the part is rendered. A part can be rendered at any time once
operations have been created. The stockwill always be shown in shades of blue. Selected
operationswill render in shades of yellow, while all other operationswill render in shades of
gray. Red will be displayed when non-cutting tool surfaces or rapidmoves hit thematerial. For
more information on Cut Part Rendering, refer to the CommonReference guide, "Cut Part
Rendering" chapter.

21. Close the Rendering palette (F6 or (Ctrl+6).

22. Choose View Top from themenu or (Ctrl+E).

This is also the same as the Home view in CS1.

23. Deselect the operations by clicking on an empty operation location or by clicking on an
insertion point between operation locations.

24. (Shift+select) the three tiles in the Process List and either drag them to the trash can or click
the Delete key.
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Multiple Process Group Op 5-8

1. For Process 1, create this Rough process
with the first Groove tool (Tool #4).

AnOD approach type is selected so the tool
will approach and retract along the X axis.
Material Only is again selected for the Rough
Style. Also, a Finished Stock amount is left on
this groove that will be removed in the
following finish pass.

In this process, we will use a Plunge roughing cycle.

When Plunge is selected for Rough Type, the Plunge dialog optionswill appear. The Plunge Angle
specifies the angle at which the groove tool will make its plungingmoves. The default is 270°
which has the tool plunging straight down.

For this process, we have selected the Details option for the CutWidth. This option will vary the
CutWidth distance as necessary in order to hit the endpoints of each feature of the cut shape.
The Z value entered specifies themaximumdistance the tool will step over on each pass. The
Center Out Cuts option is selected so that the tool will make its first plungingmove in the center of
the groove, and then proceed to rough each side.

For this groove, the Peck Full Out option is selected because the groove is relatively deep, and in
order to remove all of the chips (material), the tool will need to come all the way out of the part
after the peck. The value entered in the Peck Amt text box specifies the distance the tool will
plunge into the part on each peck. The Clearance value specifies the distance away from the
remainingmaterial the next peckwill begin.
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2. For Process 2, create this Contour process
with the sameGroove tool (Tool #4).

TheNo Drag option is turned on in this
process so that the toolpath is created in
such a way that only the positive insert
angle of the tool cutsmaterial. The
designated cut shape is segmented into
pieces to accomplish this.

3. For Process 3, create this Rough process
with the secondGroove tool (Tool #5).

AnOD approach type is selected so the tool will
approach and retract along the X axis.Material
Only is again selected for the Rough Style. Also, a
Finished Stock amount is left on this groove that
will be removed in the following finish pass.
Plunge is selected for the Rough Type.

The Exact option is selected for the CutWidth. The tool will step over on each pass regardless of the
endpoints of the cut shape. The Peck Retract option is selected for the First Plunge. The Peck Amt



Exercise #1: Turning Tutorial

28

specifies the depth of each plunge and the Retract amount specifies the distance the tool will come
out of the groove after each peck.

4. For Process #4, create this Contour
Processwith the sameGroove tool, (Tool
#5).

Now wewill define the cut shape for this process list.

5. Click the part geometry as shown.

MachiningMarkers will appear on the selected feature.

6. Right-click the last
feature shown and choose
Move End Feature here so the
MachiningMarkers appear
as shown.

Make sure you select the outside circle and the arrow pointing left. The blue cut shape drawn
should include the V groove andO-ring.

7. Create the toolpath.

The toolpaths that are created will properly rough and finish both the V groove and theO-ring.
Notice that the toolpath contains no unnecessarymoves.Material Only takes full advantage of
multiple process programming without making unnecessary tool moves.

Now look at the Operations list. Just above the list are a series of options.
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8. Click the button as shown. This will enable Tile stacking, where consecutive operations
machining the same geometry and belonging to the same flow can be stacked together, thus
reducing the space they occupy on the screen.

Note that the operation tile numbers remain unchanged.

9. Now switch to the Isometric view (Ctrl+I).

10. Render the Operations. Use the slider to slow the rendering if necessary.

During the rendering process, you will be able to better see theNo Drag contour option at work.
Notice the tool will finish one side of the groove, rapid up and over, and then go down and finish
the other side of the groove, always cutting along the positive direction of the insert angle.

11. Exit Renderingmode.

12. Switch to the Top view (Ctrl+E).

13. Deselect any operations.
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14. With the Process list selected choose Edit > Select All (Ctrl+A) and delete the tiles or drag
them to the Trashcan.

Except for the thread, the OD of our part is complete.

Creating the Operations - ID
Now, wewill create the operations to drill a hole through the center of the part and rough and finish
the ID.

Multiple Process Group Op 9-11

1. Create this Holes processwith the 0.75mmdrill tool.

The depth the drill will feed to is specified by the value entered in the Sharp Tip Z text box.
Valuesmay be entered in the text boxes specifying the Full Diameter Z depth and the Spot
Diameter. These valueswill cause the Sharp Tip Z to be recalculated. The Sharp Tip Z is the
value used in the posted output.
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The drill cannot feed through the part in one pass. Therefore, the Peck, Full Out option is selected.
Because it is a Peck, Full Out, the drill will rapid all the way out of the part after each peck.

The value entered in the Peck text box specifies the amount the tool will peck into thematerial on
each pass. The next peckwill start a Clearance amount away from thematerial remaining after
the previous peck.

i Remember to use the Balloons in the Helpmenu if you do not understand the fields.

Drilling operations do not require the selection of geometry. In a standard lathe a drill can only
feeds in at X=0. Therefore, the placement of theMachiningMarkers will only affect the toolpath
created for the Roughing and Contouring operations.

2. For Process #2, create this Rough Process
with the Triangle insert (Tool #6).

A Front ID approach type is selected so the
tool will approach and retract from the part
along the X axis. A Turn Rough Type is
selected and separate stock amounts are
entered for each axis.
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3. For Process #3, create this Contour
process again using the Triangle insert
(Tool #6).

The Front ID approach type is selected and
Material Only is turned on in the process.

4. Position theMachiningMarkers as shown.

5. Create the toolpath.

The dashed orange line at X
= 0 shows the tool rapiding
out of the part after it has
pecked in to the Sharp Tip Z
depth in the Drilling
operation.

6. Switch to the Isometric view.

7. Render the Operations.

8. Deselect the operations.

9. Clear the Process list.

Wewill skip stating these last two steps from now on.

10. Switch back to the Top view.
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Threading

Op 12

Next, we will create the operation that will cut the required thread.

1. Create this Thread processwith the Threading tool (Tool #7).
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These values can be found in theMachinery’s Handbook, and are calculated from the values
entered for an “ideal thread.”

TheMinor Xd will default to a calculated value according to theNominal Xd and the desired pitch.
The Thrd Ht Xr is calculated [(Major - Minor)/2]. Changing theNominal Xd will change the values in
theMajor Xd,Minor Xd, and Thrd Ht Xr.

Const Load is selected tomaintain the same amount of tool pressure on each pass. The Last Cut
option is selected to prevent any cut from removing less than the value entered from each side.
This is also the cut depth that the threading tool will remove on the last pass.

Threading operations do not require the selection of geometry. The information entered in the
Thread dialog determineswhere the thread will be located on the part.

2. Create the toolpath.

Cut Off

Op 13

Finally, we will create an operation to cut off themachined part from the bar stock.

1. Create this Contour Processwith the cut-
off tool (Tool #8).

AnOD approach type is selected so the
tool will approach and retract along the X
axis.Material Only is selected for the Rough
Typewith a Clearance of 0.25. The Clearance
value is relatively large to ensure that no
tool interference occurs with our finished
part.

The Cut Off option is turned on so the post processed output will contain the necessary codes for
removing the part from bar stock. Not all post processors support this option.

2. Close the Contour Process dialog.
3. Select the cut off line of the part and position theMachiningMarkers as shown.
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Ensure the end point extends past X0 and the start point begins above the stock.

4. Create the toolpath.

As the last step wewill sort the operations to have fewer tool changes.

5. Click Sort Operations from theOperations right-clickmenu.

The only change that occurs is the Drilling operation that uses Tool #2 will bemoved up in the
Operation List to location #3.

Whenever the order of operations is changed, it is good practice to verify that the
positioningmoves and toolpaths are still valid. When using the Auto Clearance option
and/orMaterial Only option, thematerial condition is taken into account when it creates
the toolmoves for each operation. Changing the order of operations has the potential
to change the initial material conditions for existing operations. Rendering the part is a
good way to check the validity of the toolpaths.

6. Select the Isometric view. (Ctrl+I)

7. Render the Operations (F6).

For this case, changing the order of the operations does not cause any tool interference and
does not appear to affect the efficiency of the toolpath and positioningmoves generated by the
system. Had there been any problems, we would have needed to reprocess the existing
operations so that the systemwould have recalculated the toolmoves for each operation based
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Redo All Ops Redo All Ops item in the Editmenu or the Operation list context menu.
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EXERCISE #2: 2D FORM TOOL
This exercise introduces you to creating and using Form Tools in GibbsCAM.Wewill start with an
existing, very simple part file, create a Form Tool and apply amachining operation using the Form
Tool.

1. Open the part file Form Tool.vnc located in the Tutorial Parts folder that was installed with the
software.

The file contains geometry for the part, a tool and two roughing operations. The existing
operations face and rough the part. First we need to create geometry for the Form Tool.

2. Create a new workgroup for the Form Tool.

3. The geometry for the form tool is provided at the end of the Tutorial, see “2D Form Tool
Blueprint” on page 45.

The system always uses the origin as the tool’s touch-off point. The part should look like this
image. In this example we have designated the non-cutting surfaces as “air” geometry. (Simply

right-click the geometry and select .)

4. Open the tool dialog.

5. Select 2D Form tool as the tool type.

You are prompted to select a shape to use for the tool’s profile.

6. Double-click the Form Tool geometry
and click Apply.

The shape of the tool is displayed in the Tool dialog window. Note the touch-off point is shown
as a red cross-hair.
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Form Tool Contour
Wewill now make a contour process using the form tool.

1. Create this Contour Processwith the form
tool.

2. Position themachiningmarkers as shown.

We have placed the start point marker above the roughed surface. The end point marker
should be on the connecting point to drive the tip of the tool to that point.
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Since we are contouring on a single line
some options become disabled when using a
Form tool.

3. Create the toolpath.

The result is a single feed line into the part.

4. Switch to the Isometric view and render the results.

5. Save this part, it is complete.
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EXERCISE #3: 3D FORM TOOLS
3D Form tools are created in a similar way to 2D Form tools.

1. In part file Form Tool.vnc, create a new workgroup for the 3D Form Tool.

2. The geometry for the 3D Form tool is provided at the end of the Tutorial, see “2D Form Tool
Blueprint” on page 45. For the purpose of this demonstration, the dimensions do not need to be

exact. You could usemouse point located in the Point section of the Geometry creation
palette to create the rough shape. It is however very important that the shape originates from
the X0 Y0 position.

The system uses the origin as the tool’s touch-off point. The tool should look like the following
image.

3. Double-click the geometry to select all. Open the Solid Modeling palette and choose the

first option, Create Solid.

4. Use the Solid Revolve tool to create a solid.

5. Open the tool dialog. Choose 3D Form tool from theMill toolset.

You are prompted to Select a shape.
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6. Click the Solid you just created and then Click Apply.

The shape of the tool is displayed in the Tool dialog.
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POST PROCESSING
Now that all of the operations tomachine the part have been satisfactorily created and verified,
we need to post process the file. Post processing will create a text file that the CNC machine will
use to cut the part.

1. Open Post Processor dialog from the Command palette.

From the Post Processor dialog a post
processor may be selected for generating a
post file and communicating with amachine

control. For more information on Post
Processing and Communications, refer to
the Turning user guide, "Post Processing"

chapter.

2. Click the Post Processor Selection button.

3. Select a Lathe post processor.

4. Click theOpen button.

The name of the selected post processor will appear in the dialog next to the button.

5. Click the ProgramName button.
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The ProgramName defaults to the name of the part
file. You can change the name or leave it as it is.

6. Click the Save button.

Once you have selected a post processor and named and saved the program, the Process
button at the bottom of the dialog becomes active.

7. Click the TextWindow button.

8. Click the Process button.

This will create a post file that can then be sent to themachine.

The programwill scroll in the right-hand window as it is being processed. You can click the
keyboard Pause button tomomentarily stop the display so that you can read the program. Once
the program has finished processing, the Print button becomes active and the posted code can
be printed.

In addition, if you have the Preferences > G-Code Editor Settings set to Internal Editor, the
GibbsCAM Internal Post editor will appear in a separate window. This customizable, color-
enhanced editor allows you to directly edit the program using cut/copy/paste etc., with multiple
subs and flows clearly distinguished. You can also find a link to this internal editor under the

Plugins > Main Toolsmenu , which will enable you to edit existing .ncf files without having
to open the .vnc file.
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PART PRINTS
Lathe Part Blueprint

2D Form Tool Blueprint

3D Form Tool Blueprint
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